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Welcome!

● In this training we will cover:
– How to analyze scWest chip images in Scout

• Opening images
• Detecting peaks
• Eliminating noise peaks
• Labeling your peaks of interest
• Visualizing your data
• Exporting data for further analysis

– Advanced features including:
• Stripping & reprobing
• Three-Plex Probing Chamber data
• Molecular weight sizing
• Normalizing data
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System Requirements

● Scout software requires 64-bit versions of  
Windows 7 and 10 or

Mac OS-X OS-X 10.11 (El Capitan), 10.12
(Sierra), 10.13 (High Sierra)

● Minimum of 16GB of RAM recommended



A reminder about chip layout

1 2 3 4 5 6 7 8

9 10 11 12 13 14 15 16

400 microwells per block

Block orientation markers

Chip orientation markers
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A simple, automated workflow for  
high quality images

1. Read all images in using auto registration.  
Peaks will be detected using default settings

2. Generate peak table for each scan

3. Run Auto Tag function for each peak table

4. Label peaks for protein targets of interest

5. Visualize data
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Key Steps to Analyzing Your Images
1. Open images

• Auto registration

• Manual registration

2. Automatically detect peaks

3. Reject unwanted sections of chip

4. Optimize peak detection settings

5. Remove noise peaks & label peaks for proteins of  

interest

• Generate peak table

• Auto Tag for automated peak curation

• Manual exclusion of remaining noise peaks

• Manual peak labeling

• Inspect function

6. Visualize data

7. (optional) Export data for further analysis

Advanced features:

• Stripping & reprobing
• Images from Three-Plex  

Probing Chamber

• Molecular weight sizing

• Normalizing peak areas

• Detecting overrun peaks



Opening Images
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Opening images

● Open new chip window and add scan  
containing loading control protein as a tab

● After analyzing first image (detailed in  
following slides), add and analyze additional  
scans as separate tabs

Opening Images Peak Detection Peak Curation Data Visualization
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Auto registration

● Can be used in most cases

● Automatically aligns your chip image, finds all 6,400 lanes
on your chip, and detects peaks in each lane with default
peak detection settings

Select which direction the
separation is occurring in  

the image

Up

Down

Alignment marker

Alignment marker

Opening Images Peak Detection Peak Curation Data Visualization
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Manual registration

● If the auto registration fails (can occur because of  
poor scan quality), use manual registration to align  
chip image

Opening Images Peak Detection Peak Curation Data Visualization
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Manual registration

1. Note whether your separations are  
occurring up or down in the image

Up

Down

Alignment marker

Alignment marker

2. Choose 2 of the 16 microwell blocks  
to register your image

3. Start Registration

Opening Images Peak Detection Peak Curation Data Visualization
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Manual registration
● Click on the center of the 1st well in first specified block and last well of

second specified block

● Software will then automatically align the images, find all 6400 lanes, and  
detect peaks in each lane with default peak detection settings

First Specified Block  
(Block 1)

Second Specified Block  
(Block 16)

Opening Images Peak Detection Peak Curation Data Visualization
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(optional) Rotating images for manual  
registration

● To input images with default  
orientation settings, chip image  
should be vertical with double dot  
feature in upper right corner

● If microarray scanner image is  
saved in the horizontal orientation,  
open Scan Properties window and  
change image preprocessing  
rotation to 0 or 180 degrees

● Save as default

● Then open images using manual  
registration

Opening Images Peak Detection Peak Curation Data Visualization
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Adding additional scans to chip

● Add additional images to the chip by repeating  
the New auto registration or New manual  
registration steps (as shown previously)

Opening Images Peak Detection Peak Curation Data Visualization
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(optional) Adjusting image contrast

Drag red handles left  
and right or change  
minimum/maximum  
window values to  
adjust contrast in  
image

Note: changing the  
contrast does not  
change the data

➢ Adjusting image contrast may be needed for manual registration when the
alignment wells are not visible with default settings.

Opening Images Peak Detection Peak Curation Data Visualization
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(optional) Reject unwanted regions

● Reject regions of the chip with:

– Major gel fouling or ripping due to handling errors

– Areas between chambers that were not probed when
using a 3-Plex Probing Chamber

Opening Images Peak Detection Peak Curation Data Visualization
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(optional) Reject unwanted regions

● To reject chip regions:
– Select lanes in any sections that you want to remove  

and mark them “Rejected” (right click, “Mark as  
Rejected” or [r])

– Apply selected lanes across all scans (right click  
menu shown below) and mark them “Rejected”  
across all scans

Opening Images Peak Detection Peak Curation Data Visualization
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Selecting multiple lanes in an image

● Pin: Click on multiple lanes to select them all (can also be  
done by holding down Shift key)

● Rubber band box: drag to select lanes within rectangular  
region (can also be done by holding down Ctrl key)

● Lasso tool: drag to select lanes within user-defined region
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How Does Scout Detect Peaks?
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Peak detection process in Scout

● Scout detects every possible peak (no  
threshold)

● Estimates which peaks are noise peaks

● Looks for all peaks that have a Signal to
Noise Ratio (SNR) ≥ 3

● SNR threshold can be adjusted by user as  
needed. Decreasing SNR threshold will  
decrease stringency in peak detection or lead  
to more peaks being detected.

Opening Images Peak Detection Peak Curation Data Visualization
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Peak detection: creation of correlation SNR plot

1. Scout defines a canonical peak shape

Peak width factor

2. Converts 2-D gel images to 1-D intensity plots
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Opening Images Peak Detection Peak Curation Data Visualization
21



Peak detection: creation of correlation SNR plot

3. Convolves shape with intensity plot

Opening Images Peak Detection Peak Curation Data Visualization
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Peak detection: creation of correlation SNR plot

4. Creates correlation plot

Peak SNR threshold (default: 3)

Peak SNR

Opening Images Peak Detection Peak Curation Data Visualization
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Peak detection: creation of correlation SNR plot

5. SNR threshold can be adjusted to detect all  
peaks of interest (if necessary)

Opening Images Peak Detection Peak Curation Data Visualization
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Optimizing Peak Detection Settings

25
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Checking default peak detection

● Once peaks are detected, scan through the  
image to see if lanes with visible peaks of  
interest are highlighted in green

● In most cases, default settings will be sufficient  
to detect all peaks

● However, if some peaks are not detected,  
proceed to optimize peak detection settings

● It is better to set peak detection settings to  
capture all protein peaks and some noise peaks  
since noise peaks can be easily removed in the  
peak curation step



Scan Properties Window
➢ Changes peak detection settings across the full image
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Changes dimensions of  
lanes used for detection

Sets migration  
direction in image

Sets image preprocessing  
(typically leave as default)

Parameters used in
peak detection

algorithm

Different methods of  
setting peak baseline Next slides provide more

detail on major parameters
to adjust



Adjusting Peak SNR Threshold

1. Select several lanes in image that have visible peaks but  
that remain undetected (lane outline still blue)

2. Plot peak correlation SNR for those peaks [c]
3. Set peak SNR threshold for the full scan below lowest

peak SNR

Measured
peak SNR

SNR threshold  
too low

SNR threshold is
good

Measured  
peak SNR

Opening Images Peak Detection Peak Curation Data Visualization
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Adjusting Lane Width

● If protein band is wider than default lane  
width, adjust lane width to include all band  
fluorescence (up to 200 microns)

Opening Images Peak Detection Peak Curation Data Visualization
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Adjusting Lane Start and Lane End

● Lane Start and Lane End can be adjusted to  
increase or decrease the length of the lane in  
which Scout detects peaks

● Can also be done on an individual lane level by  
adjusting local lane properties (see later slide)

Advanced

Opening Images Peak Detection Peak Curation Data Visualization
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Adjusting Baseline Method
● Two point baseline  

draws baseline  
between peak start  
and peak end

● Flat baseline projects  
baseline from lower of  
peak start or peak  
end points

● If peak is up against  
well, change to flat  
baseline and lower  
lane start value for  
better peak detection  
and more consistent  
peak area  
measurements

Two-point baseline Flat baseline

A = 53179A = 0

Additional peaks detected

baseline

baseline

Advanced

Opening Images Peak Detection Peak Curation Data Visualization
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Adjusting Peak Width Factor

● Changes width of canonical
peak shape used in creation
of correlation plot

● Increasing the value will  
improve detection of wider  
peaks

● Decreasing the value will  
allow detection of narrower,  
adjacent peaks

Peak width factor

Advanced

Opening Images Peak Detection Peak Curation Data Visualization
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Modifying Local Lane Properties

● Can use to find optimal peak detection settings for a small  
number of individual lanes and then apply settings to full  
chip using Scan Properties window

● Can use to detect peaks in a small number of lanes after
full chip settings are adjusted using Scan Properties

Advanced

1. Select lane of interest
2. Right click and select  

Edit Selected Lane  
Properties or type [l]

3

Opening Images Peak Detection Peak Curation Data Visualization
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Peak Curation
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Peak Curation

● Once peak settings have been optimized to  
detect all peaks of interest, use peak curation  
tools to tag (label) peaks

● Goals:

1. Tag & remove noise peaks

2. Tag peaks of interest

● “Auto Tag” function and advanced tagging  
workflows available (both detailed in this  
section)

Opening Images Peak Detection Peak Curation Data Visualization
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Peak Table

● Primary tool to rapidly
identify and tag noise
and real peaks

● Displays each peak  
detected in each  
single-cell separation

● 1 peak table is
generated per image

● Default x-axis shows  
all 6400 lanes on a  
chip

● Multiple parameters  
can be plotted on the  
x- & y-axes (detail in  
next slides)

Each point is a
detected peak

Grouping
suggests
target of
interest is
here

Opening Images Peak Detection Peak Curation Data Visualization
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Peak Table: y-axis
● Different peak parameters can be plotted on the y-axis to look for outliers,  

including:
– Peak Center: migration distance or how far the peak has traveled into the gel
– Peak Fill Factor: proportion of lane that is filled by the peak
– Prob(Protein): probability assigned by Scout that a peak is a real protein peak  

(1 = 100%). Used by the AutoTag function.
– Peak Signal to Noise Ratio
– Peak Area
– Peak Size (i.e., peak molecular weight if molecular weight sizing assay has  

been designed and run)
– Peak Width: Full width half max value (FWHM)
– Peak Height

Opening Images Peak Detection Peak Curation Data Visualization
37



Peak Table: x-axis

● Scout allows you to choose  
how to order the 6,400 lanes  
on the x-axis display

● Default is Global Col:Row  
which plots lanes one column  
at a time and clearly separates  
the adjacent chambers if 3-
chamber antibody probing  
fixture is used

● Plotting PeakFillFactor and  
other peak metrics on the x-
axis can be helpful for manual  
peak tagging

Gaps between regions with  
3-chamber probing fixture

Opening Images Peak Detection Peak Curation Data Visualization
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Automated Peak Curation: Auto Tag

● Simple Wizard that uses Machine Learning to
remove noise and find your protein targets of
interest

● How does it work?

– Neural network (machine learning filter)  
removes noise peaks due to dust, lint, etc.

– K-means clustering with outlier detection  
identifies groups of likely protein peaks based  
on up to 3 specified parameters (e.g., Peak  
Center, PeakFillFactor)

Opening Images Peak Detection Peak Curation Data Visualization
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Auto Tag Function

All detected  
peaks

Neural  
Network  

filter

K-means  
Clustering

(optional)

Good  
peaks

Bad
peaks

Tagged
“NoiseLike”

Outliers

Tagged
“AutoExcluded”

Not
outlier Prompt for tag  

for each  
cluster

Opening Images Peak Detection Peak Curation Data Visualization
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Automated Peak Curation: Auto Tag

● Open Peak Table
● Peak Table > Auto Tag
● Select up to 3 parameters (e.g, PeakCenter &  

PeakFillFactor) to use in K-means clustering  
algorithm to find peak clusters

● Set lower and upper limits which determine which  
peaks are outliers. Limits represent multiples of the  
interquartile range. Increasing values for lower and  
upper numbers will accept more peaks

● Enter number of expected peaks per lane in that  
scan.
– “Maximum” means Scout will look for at most  

this many clusters but will return the best fit for  
the data. Usually best results but slower.

– “Exact” means Scout will force the number of  
clusters. Faster but often poorer predictor of  
real peaks.

● Select whether you want to use neural net pre-filter.  
Most of the time this is useful. (See Slide 52 for  
example of situation where neural net is not useful)

● Check cluster plot if you want to display the cluster  
graph to show peak clusters and outliers (2 or more  
parameters must be selected)

● Clustering is done on untagged peaks only

Opening Images Peak Detection Peak Curation Data Visualization
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Automated Peak Curation: Auto Tag

● Scout labels noise  
peaks from Neural  
Network as “NoiseLike”.

● Scout labels peaks that  
are outliers after K-
means clustering as  
“AutoExcluded”

● Select or create a tag  
for “untagged”,  
selected peaks (should  
be peaks from your  
target(s) of interest)

● Any questionable peaks  
can be visually  
confirmed in the image  
later using Inspect  
function

Opening Images Peak Detection Peak Curation Data Visualization
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Creating a new peak tag

Name of new peak tag

Select preferred color & marker for
display in peak table

Check if want peaks to be visible in  
the peak table (e.g, you may not want 

to visualize excluded peaks)

Leave unchecked unless doing a  
molecular weight sizing assay 

(refer to advanced feature section
for more information)

Opening Images Peak Detection Peak Curation Data Visualization
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Select tag to apply to “untagged” peaks

● Label untagged peaks as AML1 peaks

Opening Images Peak Detection Peak Curation Data Visualization
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Duplicate peak tags

● If two peaks in one lane are labeled as the same  
peak, Scout will give a warning and label the  
duplicate peaks for inspection

● Duplicate peaks can be examined using the Inspect  
function and curated as needed

● Most data visualization is not possible while  
duplicate peaks remain (Lane plot is still possible)

Opening Images Peak Detection Peak Curation Data Visualization
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Automated Peak Curation: Auto Tag

● If cluster plot was checked in  
Auto Tag settings and more  
than one clustering  
parameter was selected, a  
cluster plot will be displayed  
showing clusters defined in K-
means clusters and which  
peaks are outliers vs “real”  
peaks in the cluster

● Can visually confirm that
clustering is accurate

● To change outlier definition,
delete new tags and change
upper and lower parameters
in AutoTag Settings window

Opening Images Peak Detection Peak Curation Data Visualization
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Repeat Auto Tag feature for other scans of chip

● Once peaks for all targets that you probed for have been  
labeled in all scans, you can start to visualize your data  
(detailed in next section)

647 scan555 scan

Opening Images Peak Detection Peak Curation Data Visualization
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Inspecting Peaks
The Inspect feature can be used to visually inspect the lanes in the scan
image for any peaks that are selected in the Peak Table. This is helpful if
you are unsure if a subset of peaks are real or noise.

1. Select peaks you want to inspect in the  
Peak Table using box or lasso select tools  
and by selecting or deselecting labeled  
peaks (Peak Table > Peak Table Selection)

2. Select lanes in image containing selected  
peaks (Peak Table > Scan Image  
Selection)

3. Deselect all peaks on Peak Table

4. On scan image, navigate to Tools >
Inspect > Inspect selected lanes or [i]

Opening Images Peak Detection Peak Curation Data Visualization
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Selected lane with real peak Selected lane with noise peak

5. Lanes containing selected peaks can be toggled through with left/right arrows

6. To change peak tags for any mis-tagged peaks:
• Select all peaks in lane on Peak Table (right click > Select menu)
• Tag peak(s) with appropriate tag on peak table

Alternatively, leave peaks selected on peak table before inspecting, deselect  
any mis-labeled peaks on peak table as you inspect, and tag all peaks  
remaining on selection in peak table with desired tag

Inspecting Peaks

Opening Images Peak Detection Peak Curation Data Visualization
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A note about labeling peaks

● Peaks can only be labeled in the Peak Table,  
not the image

● Selection tools should be used to identify  
which peaks to label in the Peak Table when  
looking at the image

● When selecting peaks from a lane in the  
image, remember that *all* peaks in that  
lane will be selected (if there is more than  
one peak you may need to deselect some of  
the peaks from the Peak Table)

Opening Images Peak Detection Peak Curation Data Visualization
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Hiding AutoExcluded and NoiseLike peaks (optional)

● Once peaks labeled as  
“AutoExcluded” and “NoiseLike”  
are confirmed to be noise, you  
can make them invisible so that  
only protein peaks of interest  
are shown in the Peak Table

● Edit Peak Tag and uncheck box
for “Visible”

● Can always recheck “Visible”
box to display peaks again

● Hiding noise peaks makes it  
easier to select the target  
protein peaks when AutoTag is  
not used

Opening Images Peak Detection Peak Curation Data Visualization
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Using Prob(Protein) to inspect marginal peaks

● Prob(Protein) can be plotted from the peak table and is Scout’s score of how likely a
peak is a real protein peak vs. noise

● Prob(protein) < 0.5 is considered noise

● Tight grouping near Prob(Protein) = 1.0 indicates good Auto Tagging

● Can inspect any peaks near Prob(Protein) = 0.5 using the Inspect function

Good tight grouping  
near 1.0

Could inspect this peak

Opening Images Peak Detection Peak Curation Data Visualization
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(optional) Troubleshooting neural net peak detection

● After running Auto Tag with Neural Net, if you observe a significant number of  
“NoiseLike” peaks clustered with target peaks, plot Peak Center vs. Prob(Protein) in peak  
table

● Tight grouping near Prob(Protein) = 1.0 indicates neural net is working

● If no clear grouping by Prob(Protein) is observed, neural net is not recognizing your peak  
shape. Use Auto Tag without neural net and/or use manual peak curation methods.

Good tight grouping
near 1.0

No clear Prob(Protein)  
cluster near 1.0

Significant overlapping  
“NoiseLike” & Target  

peaks

Opening Images Peak Detection Peak Curation Data Visualization
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Advanced peak curation

● If the AutoTag feature doesn’t work well for your  
experiment, numerous other advanced peak  
curation tools exist to select & label peaks in the  
peak table in a bulk fashion

– Plot peaks in Peak Table using variety of peak  
variables (e.g., Peak Center, PeakFillFactor)

– Identify & select outlier peaks

– Tag outlier peaks as “Excluded”

– Inspect questionable peaks in the image

Opening Images Peak Detection Peak Curation Data Visualization
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Selecting & Labeling Peaks in the Peak Table

Box selection tool Lasso selection tool

Opening Images Peak Detection Peak Curation Data Visualization
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Selecting & Labeling Peaks in the Peak Table

● Apply an existing tag or create a new tag to  
apply to the selected peaks

or

Opening Images Peak Detection Peak Curation Data Visualization
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PeakFillFactor

● A measure of how wide the band is in the lane

w

A.U.C.

w

p

A.U.C. = area under curve

Peak Fill Factor = 
A. U. C.

w p

Opening Images Peak Detection Peak Curation Data Visualization
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Identifying noise peaks by plotting  
PeakFillFactor on the Peak Table

● Good noise peak exclusion by combining PeakFillFactor and Peak Center location

Fiber

PFF = 0.40

Protein band Particulate

PFF = 0.47 PFF = 0.26

Opening Images Peak Detection Peak Curation Data Visualization
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Suggested Advanced Protocol for exclusion of noise peaks

● Using Peak Table, plot Peak Center vs. Peak  
Fill Factor

● Look for a cluster and use Lasso tool select
& exclude non-clustered noise peaks

● Label any questionable peaks as  
“questionable” and inspect in scan image  
using Inspect function

● If goal is to have a quick look at your data,  
just exclude peaks at extremes up to peak  
cluster and proceed with visualization

Opening Images Peak Detection Peak Curation Data Visualization
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Using Inspect Function to Review  
Questionable Peaks

● Select peaks and create/apply “questionable” tag
● Select lanes containing “questionable” peaks in the image and examine

using Inspect feature to make sure they are noise
● Deselect all peaks in Peak Table
● Toggle through lane images

– If peak is noise, select in Peak Table
– If peak is real, do not select in Peak Table

● Change tag for all selected peaks in Peak Table from “Questionable” to  
“Excluded”

● Refresh Peak Table after any protein peaks are labeled

Opening Images Peak Detection Peak Curation Data Visualization
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Rejecting Lanes vs. Excluding Peaks

● Rejecting lanes removes all peaks detected in
that lane from the peak table and subsequent
analysis

– Use only if the lane is damaged and unusable

● Excluding peaks in the peak table labels only
those peaks and does not impact analysis of
other peaks in that lane

– Use to remove specific noise peaks from  
analysis while allowing other peaks detected  
in that lane to be accepted

Opening Images Peak Detection Peak Curation Data Visualization
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Data Visualization
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Data visualization tools

Tools -> Data visualization

63
Opening Images Peak Detection Peak Curation Data Visualization



Visualization GUI
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1. Define which lanes  
to include in analysis

2. Click on the desired  
plot type



Lane Plot

● Similar to Peak Table view (shows location of
peaks in each single-cell separation) but can
show peaks from multiple scans at once

Opening Images Peak Detection Peak Curation Data Visualization
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Histogram

● Shows how protein expression varies across sample

“my target varies by 10-fold across my sample meaning that some  
cells have 10-times more of my target than others”

Opening Images Peak Detection Peak Curation Data Visualization
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Histogram of target expression  
within cell subpopulations

Example: To create a histogram of AML1  
expression only in BTUB+/GAPDH+ cells:

● Visualize lanes with BTUB and GAPDH peaks

● Create a histogram of AML1 peak areas

Opening Images Peak Detection Peak Curation Data Visualization
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1D Scatterplot

● Another way to show how protein expression  
varies across samples where each point represents  
Peak Area from a single-cell

● If no peak area is detected in a plotted lane, Scout  
will plot a peak at the specified Offset amount

Opening Images Peak Detection Peak Curation Data Visualization
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2D Scatterplot

● Identifies subpopulations of cells in data

Offset determines the  
value to plot cells that  
have no detectable  
Peak Area for that  
target

Opening Images Peak Detection Peak Curation Data Visualization
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2D Scatterplot

● Identifies subpopulations of cells in data

“94% of my cells  
express both Target 1  

& Target 2”
(value is pulled from
Enumeration plot)

Opening Images Peak Detection Peak Curation Data Visualization
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Enumeration Table

● Measures % of cells that are in a specific  
subpopulation

“94% of my cells express both AML1 & BTUB”
or

“3.2% of my cells express only BTUB”

Opening Images Peak Detection Peak Curation Data Visualization
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Export to .csv file for further analysis

Block Row Column LaneIndex PeakCenter_Target PeakHeight_Target PeakFWHM_Target PeakArea_Target

15 1 13 5613 405 2713.284191 85 275366.938

15 1 18 5618 395 545.7197048 105 61486.59261

15 1 20 5620 400 854.043649 85 80947.22122

15 1 26 5626 390 1585.09526 80 140930.5406

15 1 30 5630 400 1270.507378 100 137172.2104

15 1 36 5636 400 924.9011454 85 84462.80908

15 2 3 5643 375 881.1730159 105 102461.9676

15 2 14 5654 410 7506.546749 80 670227.7801

15 2 15 5655 395 1642.256325 100 194515.1096

15 2 16 5656 405 423.3557081 120 44959.08005

15 2 17 5657 410 2267.653581 85 213971.4297

15 2 38 5678 400 907.7824125 75 70155.69164

15 3 19 5699 400 670.6625786 105 76414.58695

15 4 35 5755 405 434.2805976 110 54547.41022

● Scout can export peak data to .csv file for
further analysis in Excel or other statistical
analysis software packages
– Each row is one lane (one single-cell  

separation)
– Columns contain information for each peak  

detected in each single-cell separation (e.g.,  
Peak Area, peak center, average background  
signal for each lane)
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Export to .fcs file

● Peak Area data can also be exported to a .fcs file  
for visualization by flow cytometry software

● Exported .fcs files can be read by FlowJo, etc.



Interpreting the results
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Interpreting the results
Run initial  
experiment

Did you get signal  
for the internal  
loading control?

Did you get signal for your target of interest?

Is the signal weak? Is the background too high?
Do you see streaking?

yes

Did you get a sharp peak?

yes

yes no

Decrease 1∘Ab conc.  

and/or incubation time

Increase 1∘Ab conc.

and/or incubation time

no

no

Try a different antibody

Is there a biotinylated  
version of the Ab?

Has the Ab been validated  
for multiple applications?

Try a different  
loading control  

or antibody

no
Do you have a  
good positive  

control?

Contact  
FAS/
Tech  

support

Try a different blocking buffer
75



Interpreting the results

How can I be confident that the signal for my  
target of interest is real?

|E|

- You observe a peak that is sharp and robust

- You observe a peak in your positive control,  
but not in your negative control

- The peak is detected at the predicted MW

- Multiple Abs against your target give the  
same peak

76



Advanced Analysis
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Analyzing 3-Plex Probing Chamber Data
1. Launch Scout software

2. Under the File menu, add first scanned image for your chip

3. Register first scanned image using auto-registration or manual alignment

4. Scout automatically identifies all the lanes in the image and all the peaks in each lane  
using default settings

5. Reject regions of the chip located between each probing chamber region that were
not probed by highlighting the regions, right clicking and marking as “Rejected” (or
keyboard shortcut “r”).

6. Open & align any other images of that chip

7. Select rejected regions in first tab, apply selected lanes across all tabs and mark
them “Reject” across all tabs

8. Optimize peak detection settings, exclude false positive peaks, label protein peaks of
interest and visualize data as normal

Note: Must use Scout 2.0 or later version to
analyze images of scWest chips probed with
a 3-plex antibody probing fixture

Advanced
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Calculating Stripping Efficiency using Scout 2.0+

● Scan your chip before and after stripping
● Load and register the ‘before’ and ‘after’ images in Scout 2.0+
● For the ‘after’ scan, adjust the peak SNR threshold to 0.1 (all

lanes should turn green)
● Generate peak tables for both images (peak table for ‘after’

image will be mostly junk peaks)
● On the peak table for the ‘before’ image, tag your peaks of  

interest, e.g. “Target_Before”
● On the peak table for the ‘after’ tab choose command: Peak

Table->Tag Matching Peaks / Stripping Efficiency
● Select “Target_Before” to match and create a new tag  

“Target_After” to apply to the matching peaks
● Accept the default matching tolerance (0.1)
● Choose “Yes” when prompted to perform the stripping efficiency

calculation

Advanced
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Calculating Stripping Efficiency using Scout 2.0+

Advanced
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Analyzing peaks that overran the lane

81

Advanced

● Change Lane Start & Lane End position in Scan Settings to move
lane for each microwell down to 950 micron starting position

647 channel 555 channel
|E|



Detecting low abundance peaks using  
Inspect function

1. Detect internal control peaks in color #1.  
Curate & label internal control peaks using  
Peak Table

2. Detect target in color #2 using default peak  
settings. Label detected target peaks using  
Peak Table.

3. Select internal control lanes in color #2 scan  
(right click on color #2 scan, Select by Peak  
Tag)

4. De-select lanes with detected target (right
click, Deselect by Peak Tag)

5. Inspect remaining lanes using Inspect  
Function (Tools > Inspect > Inspect selected  
lanes or [i])

6. Adjust local peak settings for lanes where  
target peak is visually identified to detect  
target peak but peak is not detected by Scout

Advanced
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Normalizing peak area data

● Normalizing peak area data is possible but not typically recommended as it  
can introduce additional noise to the data

● To normalize peak area data:
– Export data to .csv file
– Open up in Excel
– In new column, divide peak area 1 by peak area 2

Advanced
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Molecular weight sizing

● The standard Single-Cell Western workflow  
provides molecular weight (MW) information  
for your target relative to an endogenous  
control protein

● Two alternative approaches allow for absolute  
molecular weight quantitation on Milo:

–MW sizing using 2+ endogenous protein  
controls

–MW sizing using spiked ladder proteins

Advanced
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Molecular weight sizing

● Design assay to contain at least two proteins to be used for  
sizing ladder (e.g., β-tubulin & GAPDH)
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Advanced
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Molecular weight sizing

● Check “Use as a Size  
Standard” for any peak  
tag to be used for  
sizing reference

● Enter molecular weight

Advanced
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Molecular weight sizing

AML1 sized within <5%
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Correcting for migration variation across chip

Advanced

● Use one reference protein (e.g., β-tubulin) as a  
sizing reference

● Tools > Calculate size coefficients > Enter Size  
Reference:

– Create peak in center of well (0 microns) and  

enter 200 kDa for molecular weight

● Will remove migration drift for target(s) of interest

88



Excluding lanes that have been identified as  
doublet lane in upstream brightfield image

● Visualization tools in Scout will not differentiate between  
occupancy of 1 or 2.

● To differentiate between occupancy values when plotting
peak areas:
– Click on lanes in image that are known to have doublets  

and set occupancy to 2 (or more)
– In the Data Visualization Dataset Selector (Tools > Data  

Visualization), select Lanes with Occupancy = 1 and  
create visualization plots as normal

– Alternatively, export peak area data to .csv file.  
Exported data includes lane occupancy data in addition  
to all peak data. Plot data in .csv file for lanes with  
occupancy of 1.

Advanced
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How to handle peaks with debris on top

Advanced

90

● If lane contained a cell but the Peak Area is unreliable due to  
debris on top of the peak, lane can still be used for  
enumeration

● If neural net is used, these peaks may be labeled “NoiseLike”
– Select peak and tag it “peak-dust” (for example)
– Tag other peaks as usual

– Scout will enumerate peaks without including “peak-dust”  
in enumeration calculations (similar to rejecting lane  
entirely)

– To plot with “peak-dust” included in data, export to .csv  
and create enumeration table for (Peak OR Peak-Dust) vs.  
Target of Interest



Suggested workflow for noisy images where  
Auto Tag fails

● Load in internal control image. Detect, curate,  
and label internal control peaks

● Load in target image. Select lanes that do not  
contain internal control peaks and mark as  
“Manually Empty” on target image. Apply  
selection across all scans and mark as “Manually  
Empty”

● Peaks detected in Manually Empty lanes will not  
be shown in Peak Table

● Then curate & label remaining target peaks  
which will only be detected in lanes containing  
an internal control peak

Advanced
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A simple, automated workflow for  
high quality images

1. Read all images in using auto registration.  
Peaks will be detected using default settings

2. Generate Peak Table for each scan

3. Run Auto Tag function for each Peak Table

4. Label peaks for protein targets of interest

5. Visualize data
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More information?

Please contact:  

support@proteinsimple.com

mailto:support@proteinsimple.com


Appendix
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Adjusting Peak Slope Threshold

● Peak detection algorithm finds location  
where slope reaches a specified fraction  
of the maximum slope (peak slope  
threshold, e.g. 5%)

● Generally leave as default setting

● Increasing peak slope threshold will
bring Peak Start and Peak End point
closer to peak center

Opening Images Peak Detection Peak Curation Data Visualization
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Adjusting Area Ignore Threshold

● Scout will not return peak if  
sum of Peak Area for all  
detected peaks is less than  
the defined threshold value

Opening Images Peak Detection Peak Curation Data Visualization
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Automated Peak Curation: Auto Tag

● Upper & lower values for  
parameter selection are  
what define what is an  
outlier in the K-means  
clustering algorithm

● Value is the multiple  
applied to the difference  
between 25th and 75th 

percentile of the  
distribution of the peak  
property

Opening Images Peak Detection Peak Curation Data Visualization
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Assay optimization

98

High Background Signal Ideal Signal (low background)

|E|

Lowering antibody concentration can reduce background lysate signal


